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Downloading the Wavecrest Certificate 
The Wavecrest Certificate is downloaded using the product. 

1. Depending on your product, type one of the following URLs in the address bar of your browser: 

• CyBlock Software - http://myIPAddress:7999/cert.php 

NOTE:  7999 is the default port. Your system may be configured differently. 

• CyBlock Appliance - http://myIPAddress/cert.php 

• CyBlock Cloud - https://cloudServerAddress:9090/cert.php 

2. Press Enter. 

3. Depending on the browser that you are using, the following is displayed: 

• In Microsoft Internet Explorer, a message box is displayed at the bottom of the window. 

 

o Click Save. A message indicates that the download has completed. 

o Click Open folder to verify the location of the file. Unless the location was changed 
previously, it is most likely the default Downloads folder. 

• In Mozilla Firefox, a dialog box is displayed. 

 

o Select Save File, and click OK. A dialog box is displayed allowing you save the file. 

o Select the folder in which you want to save the file. 

o Click Save. 
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• In Google Chrome, the downloaded file is displayed in the downloads bar at the bottom of the 
tab. 

 

o The certificate file is saved to the default Downloads folder on your computer. 

4. Note the location of the downloaded file as it will be needed when installing the Wavecrest 
Certificate. 

Installing the Wavecrest Certificate Using Microsoft Internet Explorer 11 
1. In the Command bar from the Tools menu, select Internet options. 

2. Click the Content tab. 

  

3. Click Certificates and then click the Trusted Root Certification Authorities tab. 
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4. Click Import. The Welcome to the Certificate Import Wizard dialog box is displayed. 

5. Click Next. The File to Import dialog box is displayed. 

  

6. Click Browse to locate the downloaded certificate file. An Open dialog box is displayed. 

7. Select “Personal Information Exchange” for the file type, and locate and select the file. 
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8. Click Open. The File to Import dialog box displays the File name field populated with the path of 
the certificate file. 

9. Click Next. The Password dialog box is displayed. 

 

10. In the Password field, type the following: 

3Nks!V$w 

11. Select the Include all extended properties check box. 

12. Click Next. The Certificate Store dialog box is displayed. 
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13. Select the Place all certificates in the following store option, and click Browse to select 
“Trusted Root Certification Authorities.” Click OK. 

14. Click Next. The Completing the Certificate Import Wizard dialog box is displayed. 

  

15. Click Finish. A Security Warning dialog box is displayed. 
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16. Click Yes to install the certificate. A dialog box is displayed indicating that the import was 
successful. 

17. Click OK. The Wavecrest Computing certificate is listed in the Trusted Root Certification 
Authorities tab. 

18. Click Close to close the Certificates dialog box. 

19. Click OK to close the Internet Options dialog box. 

Installing the Wavecrest Certificate Using Mozilla Firefox 38 
1. From the Firefox menu, click Options. 

2. Click the Advanced panel and then the Certificates tab. 

 

3. Click View Certificates. The Certificate Manager dialog box is displayed. 

4. Click the Your Certificates tab. 

 

5. On the Your Certificates tab, click Import. The Certificate File to Import dialog box is displayed. 

6. Locate and select the file, and click Open. The Password Required dialog box is displayed. 
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7. In the password field, type the following: 

3Nks!V$w 

8. Click OK. A dialog box is displayed indicating that your security certificate and private key were 
successfully restored. 

9. Click OK. 

10. On the Authorities tab, scroll down the list of certificates, and select the “Wavecrest Computing, 
Inc. Primary EV Certificate Authority” entry. 

 

11. Click Edit Trust. The Edit CA certificate trust settings dialog box is displayed. 

 

12. Select This certificate can identify websites. and click OK. 

13. Click OK to close the Certificate Manager dialog box. 

14. Close the Options tab in Firefox. 
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Importing the Wavecrest Certificate Using Active Directory 
1. On the Active Directory server, from the Start menu, select Administrative Tools and then Group 

Policy Management. 

 

2. Double-click the Domains folder, your domain name, and the Group Policy Objects folder. 

 

3. Right-click your Group Policy object (e.g., CertPushTest) and select Edit. The Group Policy 
Object Editor is displayed. 
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4. Under your Group Policy object, double-click Computer Configuration, Windows Settings, 
Security Settings, and then Public Key Policies. 

5. Right-click Trusted Root Certification Authorities, select All Tasks and then Import. The 
Welcome to the Certificate Import Wizard dialog box is displayed. 

6. Click Next. The File to Import dialog box is displayed. 

 

7. Click Browse to locate the downloaded certificate file. An Open dialog box is displayed. 
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8. Select “Personal Information Exchange” for the file type, and locate and select the file. 

9. Click Open. The File to Import dialog box displays the File name field populated with the path of 
the certificate file. 

10. Click Next. The Password dialog box is displayed. 

 

11. In the Password field, type the following: 

3Nks!V$w 

12. Click Next. The Certificate Store dialog box is displayed. 
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13. The Place all certificates in the following store option is selected by default, and the 
Certificate store field is populated with “Trusted Root Certification Authorities.”  

14. Click Next. The Completing the Certificate Import Wizard dialog box is displayed. 

 

15. Click Finish. A dialog box is displayed indicating that the import was successful. 

16. Click OK. The Wavecrest Computing certificate is listed in the Group Policy Object Editor. 
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Installing the Wavecrest Certificate in Windows XP Professional 
1. From the Start menu, select Run. The Run dialog box is displayed. 

 

2. Type mmc and click OK. The Console window is displayed. 

 

3. From the File menu, select Add/Remove Snap-in. The Add/Remove Snap-in dialog box is 
displayed. 
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4. In the Snap-ins added to field, ensure that “Console Root” is displayed. 

5. Click Add. The Add Standalone Snap-in dialog box is displayed. 

 

6. Select Certificates and click Add. The Certificates snap-in dialog box is displayed. 
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7. Select My user account and click Finish. The Add Standalone Snap-in dialog box is displayed. 

NOTE:  You may select the Computer account option to manage the certificate for the computer 
account for all users. 

8. Click Close. Certificates - Current User is displayed in the Add/Remove Snap-in dialog box. 

 

9. Click OK.  

10. In the Console window, double-click the Certificates - Current User folder. 
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11. Right-click Trusted Root Certification Authorities, and select All Tasks and then Import. The 
Welcome to the Certificate Import Wizard dialog box is displayed. 

12. Click Next. The File to Import dialog box is displayed. 

 

13. Click Browse to locate the downloaded certificate file. An Open dialog box is displayed. 
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14. Select “Personal Information Exchange” for the file type, and locate and select the file. 

15. Click Open. The File to Import dialog box displays the File name field populated with the path of 
the certificate file. 

16. Click Next. The Password dialog box is displayed. 

 

17. In the Password field, type the following: 

3Nks!V$w 

18. Click Next. The Certificate Store dialog box is displayed. 
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19. The Place all certificates in the following store option is selected by default, and the 
Certificate store field is populated with “Trusted Root Certification Authorities.”  

20. Click Next. The Completing the Certificate Import Wizard dialog box is displayed. 

 

21. Click Finish. A Security Warning dialog box is displayed. 

22. Click Yes to install the certificate. A dialog box is displayed indicating that the import was 
successful. 

23. Click OK. The Wavecrest Computing certificate is listed in the Trusted Root Certification 
Authorities, Certificates folder. 
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Installing the Wavecrest Certificate in Windows 7 Professional/Enterprise 
1. From the Start menu, type mmc in the search box, and press Enter. The Console window is 

displayed. 

 

2. From the File menu, select Add/Remove Snap-in. The Add or Remove Snap-ins dialog box is 
displayed. 

 

3. Under Available snap-ins, select Certificates and click Add. The Certificates snap-in dialog box 
is displayed. 



Wavecrest Certificate Installation Guide 

  19 

 

4. Select My user account and click Finish. Certificates - Current User is displayed under 
Selected snap-ins in the Add or Remove Snap-ins dialog box. 

NOTE:  You may select the Computer account option to manage the certificate for the computer 
account for all users. 

 

5. Click OK. Certificates - Current User is displayed in the Console Root folder. 
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6. Double-click Certificates - Current User and then Trusted Root Certification Authorities. 

7. Right-click Certificates, and select All Tasks and then Import. The Welcome to the Certificate 
Import Wizard dialog box is displayed. 

8. Click Next. The File to Import dialog box is displayed. 

 

9. Click Browse to locate the downloaded certificate file. An Open dialog box is displayed. 
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10. Select “Personal Information Exchange” for the file type, and locate and select the file. 

11. Click Open. The File to Import dialog box displays the File name field populated with the path of 
the certificate file. 

12. Click Next. The Password dialog box is displayed. 
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13. In the Password field, type the following: 

3Nks!V$w 

14. Select the Include all extended properties check box. 

15. Click Next. The Certificate Store dialog box is displayed. 

 

16. The Place all certificates in the following store option is selected by default, and the 
Certificate store field is populated with “Trusted Root Certification Authorities.”  

17. Click Next. The Completing the Certificate Import Wizard dialog box is displayed. 



Wavecrest Certificate Installation Guide 

  23 

 

18. Click Finish. A Security Warning dialog box is displayed. 

19. Click Yes to install the certificate. A dialog box is displayed indicating that the import was 
successful. 

20. Click OK. The Wavecrest Computing certificate is listed in the Trusted Root Certification 
Authorities, Certificates folder. 

SSL Inspection 
Now that you have installed the Wavecrest Certificate, you may proceed to use the SSL Inspection 
screen in the product.  

NOTE:  By enabling SSL Inspection, applications using HTTPS communication and not utilizing Windows 
Certificate Stores for certificate validation may encounter errors. Contact Technical Support for assistance 
at (321) 953-5351, Ext. 4 or support@wavecrest.net. 

mailto:support@wavecrest.net
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